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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 
http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

In This Version 

Service Manager Version 9.21, build 157 patch 3 (SM 9.21p3) includes several customer requested software 
enhancements and fixes. Refer to the sections below for information about the defects and enhancements for 
each release included in this cumulative patch. 

Service Manager 9.21 patch 3 updates the following areas: 

• Web client updates included in SM9.21p3 

• Windows client updates included in SM9.21p3 

• Server updates included in SM9.21p3 

• Application updates included in SM9.21p3 

• Packaging_updates_included_in_SM9.21p3 

• Export_to_Excel_update 

• New parameters and RAD functions 

Web client updates  

The following items are fixed in the current software release.  

http://h20230.www2.hp.com/selfsolve/manuals�
http://h20229.www2.hp.com/passport-registration.html�
http://www.adobe.com/�
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Global ID Problem Solution 

QCCR1E31835 There is high CPU utilization when 
downloading or viewing attachments. 

There is no longer a performance issue when 
downloading or viewing attachments. 

QCCR1E55613 If a text field in a form is configured with 
upper case conversion, the Windows 
client converts the Eszett character (ß) to 
"SS", but the Web client does not. 

Note: This issue only appears in 
Microsoft Internet Explorer, and is a 
defect of Internet Explorer rather than 
Service Manager. 

When a text field in a form is configured for 
upper case conversion, the Eszett character (ß) 
is now converted to "SS" when capitalized, 
even when using Windows Explorer. 

QCCR1E58476 Form rendering on lower resolution 
screens does not work correctly on the 
web client. Any resolution less than 
1280x960 has issues rendering forms. 
For example, the search form for an 
incident or a new out-of-box incident 
form both render with a horizontal scroll 
bar located under the form component 
that has focus, instead of being justified 
to the left. This happens regardless of 
form width. 

A horizontal scroll bar is not displayed in 
resolution 1024x768 for a maximized window, 
unless the form is wide enough to require one. 

Note: HP recommends a screen resolution of 
1024x768 or higher. 

QCCR1E61250 Web client session hangs due to multiple 
DVD visible conditions.  For example, a 
visible condition for a tab based on a field 
that is on a second tab with a visibility 
condition that evaluated to false.   

Web client works normally, without hanging 
and with no errors on evaluating DVD 
conditions. 

 

QCCR1E61260 The Web client freezes after opening a 
task from a change record. The task is 
entered, but hangs the browser thread 
with an error on the page. 

The code has been modified so there a no more 
script errors and the Web client does not freeze 
when opening a task from a change record. 

QCCR1E61909 In the Web client, when moving the 
cursor using the TAB key, the populated 
value in a ComFill that has the Select 
Only property set to true is cleared. 

The populated value in a ComFill that has the 
Select Only property set to true is not cleared. 

 

QCCR1E62130 After setting Foreground Color 
Conditions on the sc.manage.problem.g 
form and the table is set to more than 7 
Foreground Color Conditions, the Web 
client hangs when loading and the user 
receives an error message. 

Code modified so that users are able to use 
more than 7 Foreground Color Conditions on 
table objects without having the Web client 
hang or receiving error messages. 

 

QCCR1E63142 The Web tier runs into an infinite loop 
when a user clicks a link in a Knowledge 
Management document that references 
an attachment with a Chinese file name. 

The Web tier now handles attachments 
properly. 
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Global ID Problem Solution 

QCCR1E63601 Attachments that have umlauts in 
filename cannot be opened. 

Attachments with umlauts in the file name can 
now be opened. 

QCCR1E63602 When user sessions are inactive for 15 
minutes or more, users receive an 
inactive message stating that they have 
been disconnected due to inactivity. 
There is also a log-in screen asking for 
Windows log-in credentials instead of the 
Service Manager login. If users click 
Cancel, then they are logged into the 
system and have an active session again. 

In the SSO/TSO environment, IIS does not 
show the authentication dialog when the 
Service Manager session is terminated but 
instead is redirected to the log-out page. 

 

QCCR1E63909 Data entered on a form can be lost when 
a newer version of the form is opened in 
another thread tab. 

When a newer version of the form is opened in 
another thread tab, the form data is properly 
processed so that all data entered on a form is 
submitted to the server. 

QCCR1E63989 Memory usage in the browser increases 
as it is used throughout the day. 

Removed a memory leak that occurred due to 
HTML event handlers not being freed right 
after a page reloads or closes. 

QCCR1E64133 When multiple entries are made to a 
table object, the table will expand but the 
other objects do not resize to fit the new 
size of the table.  

The table now works properly, so that a 
vertical scroll bar will appear automatically 
when multiple entries are added to the table. 

QCCR1E64876 Fill and DVD routines are not executed 
as expected. 

Set correct target for Data Change Event in 
listdetail, so Data Change Event can be 
executed as expected. 

Windows client updates  

The following item (identified by reference number) is fixed in the current software release.  

CR Problem Solution 

QCCR1E62102 Security issue, no details available. Security issue, no details available. 
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Server updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E23058 Combined IR-SQL searches might not 
return all correct results if the SQL portion 
of the query fetches more than 32767 rows.  

Provided a new parameter ir_sql_limit:nnn 
to influence how many rows will be fetched 
from the RDBMS to be considered for the IR 
query. The default value for the parameter 
is 32767 to emulate historic behavior. By 
increasing the parameter value, more and 
more records from SQL will be used by IR 
Expert to match its results against. 

Also added a new message which will be 
sent to the end user if Service Manager 
determines that there are more SQL records 
on the database which have been dropped 
due to this SQL limit:  

"SQL portion of combined query has been 
truncated at 32767 records. Your IR query 
result might be incomplete." 

QCCR1E31453 Read-only expressions from the dbdict are 
not correctly evaluated. 

The code has been updated so that for every 
expression, whether its read-only attribute 
is true or not, the code sets this attribute 
explicitly in response. 

QCCR1E32173 Locks are not being released when a user 
closes a thread. This occurs when a user is 
selects an interaction and then goes into the 
Search Knowledgebase screen.  From here, 
if the user clicks the "X", there is now a lock 
that will remain for the interaction.  From 
this point forward, no one can update the 
interaction. 

Locks will be released when a RAD thread 
ends so that interactions are no longer 
locked when a user selects an interaction 
and also uses Search Knowledgebase and 
then exits by clicking the "X". 

QCCR1E53965 Two issues could prevent thread dump 
information from being logged to the Service 
Manager (SM) process stdouterr.log file: 

1. When JVM option -Xrs was enabled, the 
CTRL-Break signal caused the termination 
of SM. 

2. The SM redirection of stdout and stderr 
to SM process stdouterr.log file could not 
redirect anything that the JVM prints out 
directly, such as the CTRL-Break. 

 

Added the following to help when 
troubleshooting JVM: 

1. A new Service Manager (SM) startup 
parameter, disableXrs, enables and disables 
the JVM option -Xrs. 0 = enable JVM option 
-Xrs. 1 = disable JVM option -Xrs. The 
default is 0. 

2. When a CTRL-Break signal is sent to SM, 
SM calls the printThreadDump() function to 
print the thread dump information to the 
SM process stdouterr.log file. 



 6 

Global ID Problem Solution 

QCCR1E56872 Adds and updates to triggers and link 
records require a recycle to take effect on 
other hosts in a horizontally-scaled 
environment. 

Adds and updates to cached form definitions 
and link records in one host of a 
horizontally-scaled system are now 
automatically propagated to the other hosts 
as expected. 

QCCR1E59701 When you issue "sm -reportlbstatus", the 
report sometimes includes processes that 
are no longer active. 

Service Manager Load Balancer reports the 
correct information about available ports 
and threads, and removes the non-active 
processes from its report. 

QCCR1E59739 Performing recursive Finds or drill-downs 
produce a RAD Stack Overflow error. 

Service Manager now checks the RAD Stack 
usage every time a new RAD application is 
called. Starting at 70% capacity, warnings 
are generated and sent urging the end user 
urging to terminate some RAD applications. 
If a RAD stack usage of 95% is reached, an 
error message is generated, a RAD stack 
trace is logged, and the RAD thread is 
terminated. 

QCCR1E59845 We need a way to monitor Web Services 
response time. 

You can now log response time for Web 
Services by adding rtm:2 to the sm.ini file. 

QCCR1E60130 Signal 11 could occur when RAD or 
JavaScript code is parsed as a string that is 
longer than 7200 bytes. Internally, a buffer 
overrun would occur and other data 
overwritten, causing the crash. 

Changed Service Manager to check for the 
potential buffer overrun during a parse and 
dynamically reallocate the buffer in 
question. 

QCCR1E60169 When using the LDAP Distinguished name 
field to perform the integration with an 
external LDAP server, the integration does 
not work for Web clients using Internet 
Explorer 8 as the browser. 

Problem cannot be reproduced in latest 
Service Manager version 9.21. 

QCCR1E60277 When HTTP compression is used for 
handling Web Services, the session times 
out prematurely and the request is not 
served. 

The Service Manager server sends the 
compressed responses to the Web Services 
client correctly. 
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Global ID Problem Solution 

QCCR1E60399 Table column headers in record lists are not 
rendered correctly without an scmessage 
table entry. If a caption for a field is 
changed under System Definition or Data 
Policy to a value such as "New Label," then 
when the QBE list is displayed for that 
table, the column label will be as follows: 

Message sccaption New Label Could not be 
found. 

Without a matching scmessage table entry, 
the code should take the caption from the 
datadict (data policy). 

Table column headers in record lists are 
rendered correctly. 

 

QCCR1E60590 Applications incorrectly write to an external 
file if the correct encoding is not specified in 
the sm.ini file. 

 

Added a new parameter to the "connect" 
panel to set the encoding of the file, so that 
applications can write to the file using a 
language other than the one set by the 
"language" parameter in sm.ini.  Users can 
use charsets reported by sm -
reportlanguages. 

QCCR1E61085 When setting up a file without a unique key 
as part of merged files with attribute 
subtables in the dbdict utility, the Service 
Manager (SM) server crashes with a 
GPF/signal 11. The dbdict is saved 
successfully; however, after such a file has 
been set up through dbdict utility and when 
the file is later accessed through Database 
Manager, the SM server will crash with a 
GPF/signal 11. 

Merged files require a unique key in order 
to relate records from all related tables to 
each other. SM now verifies this 
requirement before opening a merged file 
through Database Manager or while 
attempting to define such a file through the 
dbdict utility. 

QCCR1E61531 Creating a new dbdict with at least one key-
field and at least one field mapped to a 
NULLTABLE will create an incorrect 
CREATE TABLE statement. 

In the process of creating a SQL table name 
for the new dbdict, entries are filtered out 
for NULLTABLE, thus avoiding having to 
generate a CREATE TABLE statement for 
fields mapped to NULLTABLE. 

QCCR1E61845 For some application upgrades, a signal 11 
may occur when there are fields in a dbdict 
that have missing attributes. 

Modified the dbdict parsing code to 
initialize the structure of the fields properly 
even when the some of the fields have 
missing attributes.    

QCCR1E62148 When running the parameter debughttp:1, 
the server fails to log the message from the 
client when the client acknowledges or 
responds to a dialog box and when it 
responds to a heartbeat message. 

Code modified to that when debughttp:1 is 
turned on, the server logs all 
communication received from the client. 
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Global ID Problem Solution 

QCCR1E62334 When an Employee Self Service (ESS) user 
who has never logged into the system but 
exists on LDAP logs into the system, an 
operator record is created but the Template 
Operator data is not committed to the 
database. Also, the operator created has no 
full name and no role(s). 

Add code for querying template information 
when viewing records in a QBE so that 
template data is committed to the database 
when the operator is created. 

 

QCCR1E62534 When a new character field is added to a 
dbdict through the dbdict utility (mapped to 
the main table) and the dbdict already 
contains an array of structures which have 
been mapped as multi-row array tables, 
then Service Manager might generate 
CREATE TABLE statements for alias tables 
(which are not needed and contain no 
columns). 

Changed the SQL mapping routines to not 
issue any unnecessary CREATE TABLE 
statements. 

QCCR1E62535 Running the RAD function, policyread, on 
an adhoc sql file will cause an exception.  

 

Running the policyread function on an 
adhoc sql file no longer causes an exception. 
The RAD function, policyread, only supports 
standard SQL files and Join files. For other 
kinds of file types, for example, adhoc SQL 
files, the function only returns null. 

QCCR1E62573 Users may not be able to log in and may 
receive error messages, such as:  

"Unexpected error during login. 
(login,call.user.login)." 

License information is updated correctly by 
the Service Manager server, and users can 
log in as expected. 

 

QCCR1E62590 The Service Manager servlets are crashing 
on an ongoing basis.  Each time a servlet 
goes down, an 'hs_err_pid' log is created, but 
there is no indication as to why the process 
crashed. The process stops writing to the 
log. 

Fixed the loop condition so that Service 
Manager processes no longer terminate. 

QCCR1E62681 Received a signal 11 on the add.project.data 
panel of the sm.patchrel.data application 
while applying an application upgrade. 

 

Fixed a potential signal 11 in the project 
command panel which may occur when 
copying data from one array field to 
another, but the source array field contains 
scalar data. 

QCCR1E62738 Need a way to read data policy records to 
simplify application development. 

Implemented a new RAD function 
(policyread) to read the data policy records 
for applications, instead of reading the data 
directly from the database. 

QCCR1E62844 The Incident queue is not refreshed 
correctly after returning from an incident 
update. 

The Incident queue is refreshed correctly 
after returning from an incident update. 
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Global ID Problem Solution 

QCCR1E63676 The generate.list.view uses the field name 
instead of Caption in the joinfile usergrid. 

The generate.list.view now uses the caption 
(field label) in the joinfile usergrid. 

QCCR1E63715 When generating, the Sequence Number 
process failed to update the counters or 
number file. Service Manager tried to get 
the localized message from the database 
and failed again, and then ran into a 
recursive get message issue and consumed 
all the memory causing the stack overflow. 

Disabled access to the database to retrieve 
messages and fixed the stack overflow 
problem when generating sequence 
numbers. 

QCCR1E63889 IR index corruption leads to overall shared 
memory corruption, which in turn causes a 
total system failure. The Service Manager 
server has to be restarted. 

Invalid shared memory allocation requests 
are rejected. IR Index corruption no longer 
corrupts shared memory.  

Note: Corrupt IR indexes can still cause 
single sessions to crash, but no longer cause 
the whole server to crash. 

Application updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E19564 A workstation performing an export to Excel 
timed out and the client was disconnected 
by the inactivity process. 

 The Export to Excel functionality has been 
redesigned so that the Service Manager 
server process exports the data as a CSV 
(comma separated file) on the server side 
and transports the file to the client side. 
The Service Manager client then saves the 
file on the client system and launches 
Microsoft Excel to display the contents of 
the file.  

For more information, refer to 
QCCR1E58562.   

QCCR1E19570 Export to Excel supports only one Excel 
language. We want it to support exports to 
both English and Swedish versions of Excel. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562.        

QCCR1E19656 When using the Export to Excel option on a 
list view, and if there already is a Microsoft 
Excel document opened, values contained in 
the latter are overwritten by the exported 
data from Service Manger. 

This problem is fixed by the redesign of the 
Export to Excel function so that values in an 
open Microsoft Excel document are not 
overwritten when a user performs another 
export to Excel.   
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Global ID Problem Solution 

QCCR1E22123 Enhancement to Export to Excel - add an 
"Excel Language" field to specify which 
Excel version to run. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562. 

QCCR1E24775 Export to Excel times out with list of 
records greater than 16000 and greater 
than 7 columns being exported.   

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562. 

QCCR1E31151 Exporting to Excel truncates text after 
carriage return character. 

This problem is fixed by the redesign of the 
Export to Excel function.  For more 
information, refer to QCCR1E58562.        

QCCR1E31597 Export to Excel of the To Do queue should 
export module "names", not Service 
Manager table names. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562. 

QCCR1E47496 A record list of about 15,000 records 
exported to Microsoft Excel takes a long 
time (depending on machines, around 15 
minutes).  

Apparently the Export to Excel is done by 
DDE. DDE is deprecated on Microsoft, so 
will not be enhanced further. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562. 

QCCR1E47649 Some fields (or columns) in a QBE list with 
a visible condition that evaluates to false 
are being exported to Excel and may not be 
protected by capability words. Only the 
fields displayed to the user on the QBE 
screen should be exported. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562.        

QCCR1E49607 When an array field contains a tab, 
exporting to Microsoft Excel causes the 
array field to be exported to two cells. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562. 

QCCR1E51928 Using the Export to Excel feature when one 
of the columns has Chinese characters and 
the user clicks the book2 window or drags 
the scroll bar to try to see the progress, the 
first 100 or so lines are empty and the rest 
of the exported records contain garbled 
information. 

This problem has been fixed by redesigning 
the Export to Excel function.   

Note: For more information, refer to 
QCCR1E58562.        
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Global ID Problem Solution 

QCCR1E54364 Would like Service Manager to support the 
ability to export to Excel in multiple 
languages out-of-box.  

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562. 

QCCR1E54856 When exporting a QBE list to Excel, two 
copies of data were generated.  

One copy was generated in CSV format and 
a second copy was created through the DDE 
function, but the first 100+ lines were 
empty. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562.        

QCCR1E55933 When using Exporting tools (Export To 
Excel / Export To File), there does not seem 
to be a rearranged record list when 
exporting data.  

For example, if a record list is sorted with 
Company information and it is exported, the 
exported Excel list is not sorted in the same 
order. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562.        

QCCR1E56175 If you have a QBE with an Alias field as one 
of the columns. Go to Option and Export to 
Excel, the value in the Alias field is not 
exported.  

For example, when exporting product types 
to Microsoft Excel, the column "module" is 
not exported. It displays in Service 
Manager, but when it is exported to 
Microsoft Excel, the column is empty. 

This problem is fixed by the redesign of the 
Export to Excel function.   

For more information, refer to 
QCCR1E58562.        

QCCR1E56477 A dialog window cannot be closed in To Do 
Queue, when using the Export to Text File 
function to export contents to a file. 

 

Code modified so that if a dialog window 
opens during the Export to Text File 
operation, the dialog window can be closed 
after responding to the message in the 
dialog window. 
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Global ID Problem Solution 

QCCR1E58562 The current implementation of the Export 
to Excel uses client-side Dynamic Data 
Exchange (DDE) to export Service Manager 
data into a Microsoft Excel spreadsheet, 
which is slow and time consuming, as it 
involves requesting data transfer from the 
Service Manager Client to Microsoft Excel 
for every cell in the spreadsheet.  Also, DDE 
is deprecated by Microsoft, so will not be 
enhanced further. 

The Export to Excel functionality has been 
redesigned so that the Service Manager 
server process exports the data as a CSV 
(comma separated file) on the server side 
and transports the file to the client side. 
The Service Manager client then saves the 
file on the client system and launches 
Microsoft Excel to display the content of the 
file. With this redesigned functionality, the 
Service Manager server and client 
performance are both improved by using file 
exchange and eliminating XML exchange 
for exported data. 

LIMITATION: 

Excel will display a warning dialog box 
when the first line is data that includes 
"ID," such as "IDxxxx".  For more 
information, refer to the following support 
article: 
http://support.microsoft.com/kb/323626 

Packaging updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E49091 The file, scplugin.h, is not provided with 
Service Manager. 

Added the file, scplugin.h, to the Service 
Manager distribution. 

 

Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

Global ID  Known Issue  Workaround  

QCCR1E66684 When the group value of a catalog line item 
is empty, the add dependency link is not 
displayed. 

No workaround available at this time. 
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Installation Notes 

Before using patch 9.21.157 Patch 3 and all subsequent patches, you must manually remove the files listed 
below. 

Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar  

• saaj-api-2.1.jar 

• jgroups-all-2.5.0.jar 

Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 

• xalan-jaxp-1.3.2.jar 

• jaxp-api-1.3.2.jar 

• dom-jaxp-1.3.2.jar 

• sax-jaxp-1.3.2.jar 

Web Tier installation 

The Web Tier update consists of a compressed file, sm9.21.157-P3_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. For more information, refer to the Service Manager Installation Guide. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. 

To install the Web Tier update: 

1 Back up your web.xml file, splash screen, style sheets, and any other customizations you made, including 
your webtier-9.21.war (.ear) file. 

2 Delete or uninstall the existing webtier-9.21.war (.ear) file. 

Note: The "Update Application" function in WebSphere Application Server 6.x allows you to redeploy 
using a new copy of webtier-9.21.war (.ear). First, update the web.xml in the webtier-9.21.war 
(.ear) file, and then redo the shared library configuration. For more information, see the IBM 
WebSphere documentation. 

3 Deploy the new webtier-9.21.war (.ear) file by following the instructions in the Service Manager 
Installation Guide. 

4 Replace the new versions of any files you customized with your customized versions. 

5 Make any new customizations necessary for your deployment. 
Be sure to set the securelogin and sslport parameters. 

6 Restart the Application server. 
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Windows client installation 

The Windows client update consists of a compressed file, sm9.21.157-P3_Win_Client.zip, which 
contains setup.exe. 

To install the Windows client update: 

1 Stop the Service Manager Windows client. 

2 Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3 Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4 Check the version in Help > About Service Manager Client.  
The client should be Release: 9.21.157. 

Server installation 

The server update for your operating system (OS) consists of a compressed file, sm9.21.157-P3_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the [SM 
Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 

To install the Server update: 

1 Stop all Service Manager clients. 

2 Stop the Service Manager server. 

3 Make a backup of the RUN directory. 

4 Extract the compressed files for your operating system into the main Service Manager directory on the 
server. The default path is:  C:\Program Files\HP\Service Manager 9.21. 

5 For UNIX servers, set the file permissions for all Service Manager files to 755. 

6 Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar 
• saaj-api-2.1.jar 
• jgroups-all-2.5.0.jar 

7 Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 
• xalan-jaxp-1.3.2.jar 
• jaxp-api-1.3.2.jar 
• dom-jaxp-1.3.2.jar 
• sax-jaxp-1.3.2.jar 

8 Restart the Service Manager server. 

9 Restart the Service Manager clients. 

10 Check the version in Help > About Service Manager Server.  
The server should be Release: 9.21.157. 
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Application unload installation 

The application consists of the unload files that come with the server updates. When you extract 
sm9.21.157-P3_<OS>.zip (or .tar), it will add the new files to your  
[SM Root]\platform_unloads ([SM Root]/platform_unloads) directory.  

Unload file naming convention 

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where: 

• <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. Note that this is always the number of a parent CR. 

• SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 
and should be used for patch 2 or higher.  

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This 
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.  

• SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
which means the unload file is intended only for Service Manager applications version 7.11. 

Note: If this suffix is omitted, the unload file is then intended for all applications versions compatible 
with the current server version. For example, for Service Manager server 9.21, the compatible 
applications versions are 7.11 and 9.20. 

New application updates in the current patch 

The following are new unload files introduced in the current patch release. 

For SM apps 7.11:  

• QCCR1E56678_SM921P3_SM711.unl, which lists the records in the right group order when a record list 
is refreshed. 

• QCCR1E58562_SM921P3_SM711.unl, which includes applications changes for Export to Excel redesign. 

• QCCR1E49721_SM921P3_SM711.unl, which enables translation of Display/Value lists on dynamic 
forms. This is a required fix for the Export to Excel redesign. 

For SM apps 9.20:  

• QCCR1E58562_SM921P3_SM920.unl, which includes applications changes for Export to Excel redesign. 

Export to Excel update 

The Export to Excel functionality has been redesigned so that the Service Manager server process exports 
the data as a CSV (comma separated file) on the server side and transports the file to the client side. The 
Service Manager client saves the file on the client system and launches Microsoft Excel to display the 
contents of the file. With this redesigned functionality, the Service Manager server and client performance 
are both improved by using file exchange and eliminating XML exchange for exported data. 

To install the new applications load the following unload files: 

Used for SM7.11 apps: 

• QCCR1E58562_SM921P3_SM711.unl, which includes applications changes for Export to Excel redesign. 
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• QCCR1E49721_SM921P3_SM711.unl, which enables translation of Display/Value lists on dynamic 
forms. This is a required fix for the Export to Excel redesign. 

Used for SM9.20 apps. 

• QCCR1E58562_SM921P3_SM920.unl, which includes applications changes for Export to Excel redesign. 

To export data to Excel after loading the files: 

1 In the Windows client, go to Window > Preferences to make sure that the option, Client side load/unload 
is selected. 

2 From a record list, select Export to Excel. The file selection window opens. 

3 Select the Excel file to which you want to export the data. You can also type a new file name and Service 
Manager will create the file. 

4 Click the check mark icon. The data will be exported correctly and saved in .CSV format by default. 

Application updates in previous patches 
Additional application updates have been included with this cumulative release. If you have not already 
applied them for a previous patch, you should also apply the unload files specific for your applications 
version (see the following table). For more details, see the Release Notes for those patches. 

Unload file Comes 
from 9.21 
patch 

Used for 
applications 
version(s) 

Description 

QCCR1E55715_SM921p1.unl P1 7.11 and 9.20 Includes application changes to 
reduce database I/O on login. 
 

QCCR1E57767_SM921p1.unl P1 7.11 and 9.20 Includes application changes to 
reduce jgroups traffic on login. 
 

QCCR1E59753_SM921p2.unl P2 7.11 and 9.20 Includes application changes to 
fix the ToDo bar.  
 

QCCR1E31545_SM921P2_SM711.unl P2 7.11 Prevents backslashes included in 
a template from being duplicated 
in the output. 

Note:  This file is not required 
for Applications 7.00. 

QCCR1E31545_SM921P2_SM920.unl P2 9.20 Prevents backslashes included in 
a template from being duplicated 
in the output. 

To load an unload file: 

1 Select either client or server-side unload, depending on the location of the unload files. 

a) From the Windows client, go to Window > Preference > HP Service Manager.  

b) Flag Client-Side Load/Unload if the files are on the client machine, and clear the flag if not.  

c) Restart the Windows client if you changed the setting.  
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2 Open Tailoring > Database Manager. 

3 Right-click the form or open the options menu and select Import/Load. 

4 Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5 Click Load FG.  
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New parameters and RAD functions 

Several defects fixes are supported by new or updated parameters and RAD functions. 

New parameters: 

• Startup parameter: disableXrs 

• Information Retrieval (IR) expert parameter: ir_sql_limit 

• RAD_function_policyread 

Startup parameter: disableXrs 

Note: For additional information, see QCCR1E53965. 

Startup parameters change the behavior of the HP Service Manager server. You can always set a startup 
parameter from the server's OS command prompt. This parameter determines how a HP Service Manager 
server manages client connections. 

Description  

The Service Manager process creates a JVM and provides default option of -Xrs on startup to reduce the 
signals to be handled by the JVM. However, you may want to generate thread dumps for debugging 
purposes, and then you would want the JVM to receive these signals. Use the parameter -disableXrs in 
sm.ini, so that the Service Manager process will not provide this option to JVM.  

Notes:  

• This parameter is honored only in Windows environment for debugging purposes.  

• If you use Remote Desktop and start a Service Manager process using disableXrs:1, and then close 
the session or log off, the Service Manager process will be shut down.  

Valid if set from  

Server's OS command prompt  

Initialization file (sm.ini)  

Requires restart of HP Service Manager server?  

No  

Default value  

0  

Possible values  

0 = enable JVM option -Xrs  

1 = disable JVM option –Xrs  

Example usage  

Command line: sm -httpPort:13080 -disableXrs:1  

Initialization file: disableXrs:1  

 

 



 19 

Information Retrieval (IR) expert parameter: ir_sql_limit  

Note: For additional information, see QCCR1E23058. 

The IR expert parameters determine how HP Service Manager indexes and retrieves information using IR 
Expert. You can set these parameters from the HP Service Manager server's OS command prompt or from 
the HP Service Manager initialization file (sm.ini). 

Description  

This parameter determines how many records are fetched from an RDBMS in a combined IR and SQL query.  

This parameter does not affect pure IR queries (queries that only involve IR indexed fields) or pure SQL 
queries. It only affects queries that involve some fields that are indexed by IR and some that are not. 

Valid if set from  

Server's OS command prompt  

Initialization file (sm.ini)  

Requires restart of HP Service Manager server?  

Yes  

Default value  

32767  

Possible values  

The maximum number of records to be fetched from the RDBMS for a combined IR and SQL query.  

Example usage  

Command line: sm -httpPort:13080 -ir_sql_limit:20000  

Initialization file: ir_sql_limit:20000  
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RAD function: policyread 

Note: For additional information, see  QCCR1E62738. 

This is a RAD function that reads the data policy from the datadict table. 

Format 
$L.returnvalue = policyread($L.file, fieldname, fieldsetting) 

Parameters 

Parameter Description 

$L.returnvalue The policy value returned after it is read from the database.  
It can be a string, a Boolean, or null. 

$L.file The file handle of the table for which the data policy information is to be read from the 
database. 
It can be a join table or a normal table.  

Note:  Other kinds of tables (adhoc sql, merge files, etc.) are not supported. 
This is the value in the Name field in the datadict record. 

Fieldname The name of the field in the specified table for which the data policy information is to be 
read from the database.  
This is the value in the Field Name field in the datadict record. 

Fieldsetting The field setting on the specified field for which the data policy information is to be read 
from the database.  
This is one of the fields on Field Settings tab of the datadict record.  
Valid field settings are: "invisible", "readonly", "mandatory", "captions", "avail", "encrypt", 
"defaults", "globallist", "matchfields", "matchfiles", and "validations". 

Factors 
If the fieldsetting is not in the list of Field Settings in the datadict table, the server will return an error 
message. In any other case, this function returns a valid value or null. 

Example 1 
This example demonstrates how you could use a JavaScript to access the data policy on a simple file, such as 
the operator table.  

// Access DataPolicy definition on operator file. 

var operatorFile = new SCFile( "operator" ); 

var rteReturn; 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "invisible" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:invisible) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "readonly" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:readonly) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "mandatory" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:mandatory) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "captions" ); 
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print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:captions) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "avail" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:avail) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "encrypt" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:encrypt) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "defaults" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:defaults) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "globallist" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:globallist) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "matchfields" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:matchfields) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "matchfiles" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:matchfiles) " + rteReturn ); 

rteReturn = system.functions.policyread( operatorFile , "profile.change", "validations" ); 

print( "DataPolicy on (file:operator, fieldname:profile.change), as defined in (file:datadict, 
field:validations) " + rteReturn ); 

Example 2 
This example demonstrates how you could use a JavaScript to access the data policy on a complex file, such 
as a join of the incidents and contacts tables.  

// Access DataPolicy definitions on join file inccontacts (incidents and contacts) 

var incident_contacts_file = new SCFile( "inccontacts" ); 

var rteReturn; 

// Access policy definition on file(contacts) and field(city) and datadict field defaults 

rteReturn = system.functions.policyread( incident_contacts_file, "file.contacts,city", "defaults" ); 

print( "DataPolicy on (joinfile:inccontacts, subfile:contacts, field:city), as defined in(file:datadict, 
field:defaults)" + rteReturn ); 

 

// Access policy definition on file(incidents) and field(phone) and datadict field defaults 

rteReturn = system.functions.policyread( incident_contacts_file, "file.incidents,phone", "defaults" ); 

print( "DataPolicy on (joinfile:inccontacts, subfile:incidents, field:phone), as defined 
in(file:datadict, field:defaults)" + rteReturn ); 

 

// Access policy definition on file(incidents) and field(phone), and datadata field readonly 

rteReturn = system.functions.policyread( incident_contacts_file, "file.incidents,phone", "readonly" ); 

print( "DataPolicy on (joinfile:inccontacts, subfile:incidents, field:phone), as defined 
in(file:datadict, field:readonly)" + rteReturn ); 
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Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  

1 Use a browser to navigate to the Software Support Online (SSO) web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

Support 

You can visit the HP Software support web site at: 
www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 
http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 
http://h20229.www2.hp.com/passport-registration.html 

http://support.openview.hp.com/sc/support_matrices.jsp�
http://h20230.www2.hp.com/new_access_levels.jsp�
http://h20229.www2.hp.com/passport-registration.html�
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notice 

© Copyright 1994-2011 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

• Adobe™ is a trademark of Adobe Systems Incorporated. 

• Java™ is a registered trademark of Oracle and/or its affiliates. 

• Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

• Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

• UNIX® is a registered trademark of The Open Group. 

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 
web site and search for the product manual called HP Service Manager Open Source and Third Party 
License Agreements. 
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